Getting Started With ArcGIS
2005 SPACE Workshop – OSU
Author: Jason VanHorn
Purpose: This lab has been designed to help guide you through a review of the ArcGIS
software. Like all software, there is a certain language that is associated with certain
application. You can expect to become familiar with the ArcGIS language, components
and applications through this lab.
Objective: To be come more familiar with ArcGIS through example.
Section 1.
A short history on the evolution of ArcGIS
Environmental Systems Research Institute (ESRI) in was founded in 1969 in
Redlands, CA. From its earliest stages, ESRI was focused on the organization and
analysis of geographic data. With the advent of the personal computer in the 1980s,
ESRI’s focus was on the software application development of ARC/INFO. According to
the ESRI website, they first developed ARC/INFO in 1982 for minicomputers and by
1986 a PC version for the personal computer was distributed.
ARC/INFO is a command-line based software package that handles both vector
and raster geographic data and is an industry standard tool that has been developed since
the 1980s.
In contrast, a much less exhaustive ESRI software package called ArcView was
released in the early 1990s. Although not as comprehensive as ARC/INFO, ArcView has
one major advantage over its big brother, a graphical user interface (GUI).
With its GUI, ArcView has become one of the most popular GIS packages
worldwide. However, by 2000, ArcView 8 was released, which was better known under
its new name ArcGIS. ESRI combined many of the features of ARC/INFO into a
redesigned GUI to produce an all-in-one GIS system. In addition to the ArcGIS package,
many extensions are available as Add-On’s to “extend” the software capabilities, such as
through such extensions as GeoStatistical Analyst, 3D Analyst, Network Analyst, and
Spatial Analyst, just to name a few. We will be using ArcGIS 9.0 in our labs during this
workshop.
Section 2.
Essentials for lab work using ArcGIS
I.

II.

Log on to machines
To log on to the machine please use this username and password
• Username: space
• Password: space2005
File naming
Although ArcGIS runs in a Windows based environment, it is HIGHLY
recommended that you name all of your files as if working in a restrictive
command-line environment. That simply means, that you should:
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A. Never, ever, never have any SPACES in your file/folder names.
B. Always limit your file/folder names to 12 characters or less if
possible.
III.

How to save your work
In the lab environment, it is essential that you stress saving your work. Often,
however, when work is not saved many hours of grief and work may result.
Therefore please follow the simple procedure for saving your work.
A. Work on your local machine
Often working across a network or to a zip drive can be very time
consuming. Therefore, work on your local machine.
1. First create a folder on the c:\workspace location.
2. Name it with your surname and first initial, (e.g. jvanhorn).
3. Make sure there are NO spaces in your folder name.
B. Save your work
1. Save all of your work in your newly created folder on the
c:\workspace\yourname drive location.
2. Feel free to create new folders under your folder, just make sure there
are NO spaces in your folder/file names.
C. Copy your work to your removable drive
1. When you are finished or at a stopping point for the day, insert your
Zip-disk or your memory key into the computer and copy your
c:\workspace\yourname folder onto your removable drive. This will
ensure that everything in your folder is copied over to the removable
drive.
2. Remove your removable media and take it with you.
D. Working at a new workstation
1. Now that you have all of your work saved on your removable media,
for which ever workstation you choose to work on, all you need to do
is copy your folder (yourname) to the c:\workspace. This will ensure
all of your files are present on the local drive AS WELL AS your path
names of your folders and files are the same as when you saved them.
2. When you are done working for the day at that workstation, repeat step
C.

Section 3
Navigation in ArcGIS 9.0
ArcGIS is comprised of three parts that work in synergy with one other,
ArcCatalog, ArcMap, and ArcToolbox. “ArcCatalog is the application for managing
your spatial data holdings and database designs and for recording and viewing metadata.
ArcMap is used for all mapping and editing tasks, as well as for map-based analysis.
ArcToolbox is used for data conversion and geoprocessing” (ESRI 2004).
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ArcCatalog
1. Open ArcCatalog | Start>All Programs>ArcGIS>ArcCatalog
2. If you have not done so, please create your folder on the c:\workspace location.
3. Connect to the w:\space\2005\Lab\ and copy the folder Greenvalley intro_lab to
your c:\workspace.
4. Open to Greenvalley\Data\GreenvalleyDB.mbb in ArcCatalog on your
c:\workspace.
5. Notice there are 5 different layers associated with this Geodatabase; Hydrology,
Parks, Public Buildings, Public Utility, and Transportation.
6. Double-click Transportation and notice that the “Contents” tab shows that there is
an street_arc layer.
7. Select the “Preview” tab and see the geography of the network.
8. Now at the bottom of the “Preview” window, change the Preview: to table. Now
you are looking at the attribute table of the street_arc layer. Notice that the street
network is made up polylines and that some of the arc’s have street names.
9. Finally select the “Metadata” tab. Notice that this gives you information about the
layer in the form of description, spatial, attributes. Select the “spatial” tab and
notice that the coordinate system information as well as the spatial bounds are
provided. Scroll down and click on street_arc. Notice that information regarding
the arc layer is given.

Refresher: Using ArcCatalog, you can organize and deal with your Geodatabase
through a series of trees and tabs, allowing you to preview the geography, tables, and
metadata associated with your spatial layers.
ArcMap
From the ArcCatlog standard toolbar, launch ArcMap. See below.
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In ArcMap, open an existing map …\Greenvalley\Greenvalley.mxd.
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Figure 1. Layout of ArcGIS
As you can see we have the Table of Contents (TOC) on the left side of your screen.
In this case, you have point, line, and area features in your TOC. You can switch
between the Data View, which contains your geographic data to your Layout View,
which is used for final production output (A Map). Also notice that in the lower right
of the screen you have your coordinate system and in the upper right you can see the
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“Tools” toolbar which has your zoom and pan options as well as your id and selection
tools. Finally, in the far lower left of the Figure 1 you see Navigation Tabs. These are
new to ArcGIS 9.0. The ‘Display’ tab works like the normal TOC, where you can
promote or demote layers, rename your layers and change colors. The ‘Source’ tab
lets you see the paths or sources of your files, as well as, your imported tables. (eg.
c:\workspace\yourfolder\street_arc.cov) . Lastly, the ‘Selection’ tab allows you to
deal more efficiently with selection you made. Feel free to play around with these
new features if you have not seen them before.
1. With the ‘Display’ tab selected, move the layer street_arc to the top of the TOC.
Using this drag and drop method, you can easily promote or demote layers in the
TOC.
2. Now Right-click on the street_arc name and choose properties. You should see
this window on your screen:

’Layer Properties’ is a dialog box which provides the different characteristic
properties associated with your layer.
3. In the ‘General’ tab of the Layer Properties dialog box, change your Layer Name:
to streets and click Apply. Now notice your TOC name has changed from
street_arc to streets.
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4. Select the ‘Source’ tab in the Layer Properties dialog box. Notice that you have
extent information about the bounds of your Geodatabase, as well as, path
location information and coordinate information. Notice that the projection for the
Greenvalley Geodatabase is PCS_Transverse_Mercator or in plain language the
Transverse Mercator Projected Coordinate System.
5. Now select the ‘Fields’ tab. Notice that you see the same fields as was in the
ArcCatalog for street_arc. You can see database field information about each of
the fields (columns) such as type or precision.
6. Now select the ‘Symbology’ tab. Here is what you should see:

Notice that you have a ‘Show’ feature box on the left which contains the
headings, “Features, Categories, Quantities, Charts, & Multiple Attributes”. Also
see that there is a symbology setup to deal with different Value_Fields that are
associated with your layer, which means that you can symbolize any of the
different Value Fields. Click the drop-down and see what different Value Fields
there are for this layer. Also see you can change the Color Scheme for the
symbolization. In the feature box you can see that the Value Field “Type” has
been selected which designates the different types of streets in the layer by
number. 3 corresponds to Major Roads, 4 corresponds to Primary Streets, and 5
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corresponds to Secondary Streets. Play with the Color Schemes and change the
colors, then hit apply to see your new symbology. Now double-click on the color
bar to the left of the number ‘3’. With this dialog box:

you can change the color of the individual types as well as incorporate predesigned templates such as colors and thickness to types that correspond to your
type. Select Major Road from this dialog box and click OK, then click Apply.
Now your road should be represented with a 1.5 width thickness and should be
the color black. Close the Layer Properties dialog box. Save your work.

Now lets explore the map a little. If your ‘Tools’ toolbar is not showing, Under the
main menu, select View>Toolbars>Tools and this toolbar should be
displayed. With the ‘Tools’ toolbar, click on the ‘Globe’ icon and notice
that the entire map is displayed for Greenvalley. The ‘Globe’ icon gives
you the full extent. Now put your mouse over each of the different icons
and you should see a short description of the function of each of the
icons on the ‘Tools’ toolbar. What do the binoculars do? Well let’s find
out together. Click the binoculars tool which will help us find features
on our map. In the ‘Find:’ type Police Headquarters of the Find dialog
box. Now with the drop-down menu of ‘In:’ choose buildings_point. Now check the
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radio circle ‘In fields:’ and choose Name. Your dialog box for Find should look like
this:

now click the ‘Find’ button in the upper right of the dialog box. The database is now
searching for the information we requested. It found 1 data named ‘Police
Headquarters’. Right-click on the name in the results box and select ‘Zoom to
Feature’ Now you have located the Police Headquarters for Greenvalley. Close the
Find dialog box. Choose the ID icon from the ‘Tools’ toolbar and click on the star
that represents the Police Headquarters. Now you can see all the attribute information
in an ‘Identify Results’ dialog box for that feature. Close the dialog box and now play
with the ‘Fixed Zoom Out’ button

and the ‘Back to Previous Extent’

.

Finally use the ‘Pan’ option to ‘grab-and-drag’ your way around the map.

Now lets do some intermediate procedures.
1. Please close any dialog boxes that are open and click the ‘Globe’ in the Tools
toolbar to make the extent full. Save your work.
2. Now add a new layer to the map using the ‘Add Data’ button.
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3. Navigate to your Greenvalley folder and select WaterUse.lyr. Click Add.

4. Notice now, there is a new layer added to the map. In the TOC, Right-Click on
the parcels_polygon layer and choose ‘Zoom to Layer’.
5. Now you should see the water use polygons for a subsection of Greenvalley.
Notice that the numerical range for the polygon layer establishes which polygons
have high water usages (7-8-9) and those that have low or none(0, 1-2). Open the
attribute table for this layer by Right-clicking and choose ‘Open Attribute Table’.
Explore the fields of the table.
6. Now, let’s join this layer with a .dbfIV file so that we can see what type of zoning
each polygon has. First, we need to add the land use table we are going to use.
Click on ‘Add Data’ button, the same as you did above (the ‘plus sign’ button)
and navigate to the Greenvalley folder. Select the landuse.dbf database file and
click Add.
7. In the TOC, Right-click on the newly added landuse.dbf file and choose open.
This allows you to see the attribute table for the database. Notice there are several
different types of land uses associated with unique Federal ID numbers (FID).
Close the table when done.
8. Now click on the ‘Display’ tab at the bottom of the TOC. Right-click on the
parcels_polygon layer and choose ‘Joins & Relates’>’Join’.
9. We will now join the parcel water use layer with the land use data. In the Join
Data dialog box select ‘Join attributes from a table’ from the drop-down menu. In
the ‘1. Choose the field in this layer that the join will be based on:’ choose FID.
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10. In the ‘2. Choose the table to join to this layer…’ select landuse from the dropdown menu.
11. Finally, for ‘3. Choose the field in the table to base the join on:’ choose FID_1
from the drop-down menu. Your dialog box should look like this:

12. Click OK and choose YES to automatically create an index, if prompted.
13. Now Right-click on the parcels_polygon layer and choose to ‘Open Attribute
Table’. Notice the column headings have changed (indicating that a join is in
place) and that the landuse information is now present in the table. Close the
attribute table when done.
14. Now lets see what types of land use zones are using the most water in
Greenvalley. Start by Right-clicking on the parcels_polygon layer and selecting
‘Properties’.
15. Select the Symbology tab and then change the color of the color ramp to
something like ‘brown’. Click ‘Apply’ and close the dialog box. Save your work.
16. Now on the main menu choose Selection>Select By Attributes. We are going to
create a query to answer our question, “What types of land uses are associated
with the highest usage of water?”.
17. For ‘Layer:’ choose parcels_polygon. For ‘Method:’ choose to ‘Create a new
selection’.
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18. In the ‘Fields’ attribute box, double-click on parcels_polygon.USE_CLASS. This
will take the attribute down into the query box.
19. Now choose the ‘greater than & equal to’ button and then type the number 7. This
will create a query, SELECT *From parcels_polygon_landuse WHERE:
parcels_polygon.USE_CLASS >= 7, which will give us all the parcels that have a
water usage of 7 or greater. Click Apply, then Close.
20. Notice now that some of the polygons are selected. These are the areas in
Greeenvalley that use the most water. Now Right-Click on parcels_polygon and
choose ‘Open Attribute Table’.
21. Look at the bottom of the ‘Attributes of parcels_polygon’ dialog box, you can see
that there are 18 out of *2000 records selected.
22. Click the button that reads, ‘Selected’ and notice now you see the 18 records that
were selected from the query. At the bottom of the ‘Attributes of
parcels_polygon’ dialog box, click on ‘Options’ and choose to ‘Export’. Save
your file in the Greenvalley folder as hwu_landuse.dbf (High water use and
landuse). Add the new table to the map. Close your table.
23. Click on the ‘Source’ tab at the bottom of the TOC and you will then see that the
table hwu_landuse is now in the Table of Contents. Right-Click and Open the
table and notice now that the field columns are named their original names and
that the join data is now in one complete file for the selected tuples (rows) of data
you previously exported.
24. Look at the far right column of LANDUSE. Notice that there are many different
types of landuse. Good data is always accompanied by good metadata, so that is
where we will look to see if we can find a definition for each of the LANDUSE
types. Sort the data (Ascending) by Right-clicking the column label LANDUSE
and choosing to Sort Ascending. Notice that HDR seems to be most common. But
what does HDR stand for? That is what we will answer next.
25. If you do not have ArcCatlog open, please open it and navigate in the TOC to
the location of the Greenvalley folder you are presently using. Click on
landuse.dbf and then on the Metadata tab next to the Preview tab.
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The metadata associated with the file should appear. However, we are going to
change the format of the metadata to something a little more standard. In the
Stylesheet: drop-down box just above the TOC, please change it to FGDC FAQ.
According to ESRI (2004), “ArcGIS provides several predefined stylesheets—the
default is the ESRI stylesheet, which you used earlier. You can also create your
own stylesheets. The FGDC FAQ stylesheet was developed by the Federal
Geographic Data Committee to present the metadata in the form of a set of
frequently asked questions. This format lets you see the values for each attribute
in a layer (as long as they’ve been defined in the metadata)”.
26. From the FAQ choose under ‘The Frequently-asked questions’ > ‘What does this
data set describe?’ > ‘7. How does the data set describe geographic features?’.
27. Now you can see what the values are for each of the LANDUSE types in the file
landuse.dbf.
28. Go between ArcCatalog and ArcMap and make notes of which types of landuse
are represented in the file hwu_landuse. Feel free to use the blanks below:

Landuse Value

Landuse Type

Count

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

________

__________________

____

29. Circle above which two landuse types are most common by count. Does that
make sense? Now look at the rest of the land use types. Are there any that stand
out as not making sense?
30. You should have answered that VAC and VLDR do not make any sense because
these are listed as being unoccupied by landuse. There is an apparent discrepancy.
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This points out the problem that often exists with datasets. Either the data is
wrong, or represents a different time frame, or there is further information that
you need to have to understand the discrepancy. So please be cautious when
working with real datasets that you have a method for validation and reliability of
your data and you understand the scale and time frame the data was collected.
31. Please save your work in ArcMap and close your attribute table.
Congratulations! You have made it through the basic and intermediate section of Getting
Started With ArcGIS. Many of the procedures covered in this section are common
everyday practices that you should have mastered in no time.

ArcToolbox
Having explored ArcCatalog and ArcMap and some of the basic and intermediate
procedures in each, now it is time to see a little of what ArcToolbox can do.
Remember that ArcToolbox is part of the ESRI suite that deals with conversion of
data and geoprocessing operations. So let’s begin.

Here is what the city of Greenvalley wants: The city is interested in building a new
park on a vacant lot of the city. However, they have some restrictions regarding
where it can be built. Their restrictions are as follows: the park has to be located on a
vacant lot that is at least 2000 square meters and is not within 200 meters of an major
roads to account for children’s safety.

So lets try and help them out. However, this time the instructions will be somewhat
vague for operations that you have already accomplished in the previous sections.
The part using ArcToolbox, however, will be specific.

1. First lets build a query. Remember how to build a query? Build a query so that
you are making a selection from parcels_polygon of land uses that are vacant and
that have a shape area of greater than or equal to 2000. (HINT: With
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landuse.LANDUSE selected, click on the ‘Get Unique Values’). How many
parcels were selected? You should have gotten 13 parcels as being selected.
2. Now open the ArcToolbox. It is the little red box on the main menu (see below)

3. As you can see ArcToolbox is fully incorporated into ArcGIS 9.0 unlike previous
versions (if you are familiar with previous versions). There are several different
effective and powerful tools in the toolbox and today we are going to use a couple
of geoprocessing options in the Analysis Tools section of ArcToolbox.
4. Within ArcToolbox choose Analysis Tools > Extract >Select and double-click on
Select.
5. You should now be in a Select dialog box. For ‘Input Features’ choose the
parcels_polygon from the drop-down. For the ‘Output Features’ make the path,
C:\workspace\yourname\greenvalley\parcels_polygon_Select (notice that this is a
shorter path than the default you are given). Click OK.
6. Now a toolbox dialog script will open and run. Close it when it is done.
7. In your TOC you should now see a new layer has appeared called
parcels_polygon_Select. The Select option in Analysis Tools will take any
selection of a layer you make and then creates a new shapefile layer.
8. Turn off the layer parcels_polygon by ‘unchecking’ the layer in the TOC.
9. Now you should clearly see the vacant lots in Greenvalley that are greater than
2000 square meters. Good job!
10. Also let’s turn off the buildings_point layer and the parks layer in the TOC as
well since we don’t need it presently.
11. Now zoom to the parcels_polygon_Select layer. Remember how to ‘Zoom to a
Layer’?
12. Now we are going to buffer the vacant lots. In the ArcToolbox choose Analysis
Tool > Proximity > Buffer.
13. Input Features should be parcels_polygon_Select and go ahead and keep the
default path
c:\workspace\yourname\greenvalley\parcels_polygon_Select_Buffe.shp
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14. Notice the Linear unit changed automatically to Meters. In the input box below
the Linear unit label, enter in ‘200’. This will buffer around all of the parcels out
200 meters in Euclidean distance. Click OK.
15. Now you have a new layer in the TOC, parcels_polygon_Select_Buffe. This
shows the buffers of 200 meters around all of the vacant parcels that are greater
than or equal to 2000 square meters.
16. Now lets see if there are any roads crossing through those buffer zones. In
ArcToolbox, choose the Analysis Tools > Overlay > Intersect.
17. In the dialog box, for Input Features, choose parcels_polygon_Select_Buffe AND
streets from the drop down menu. For your output path and file name choose
c:\workspace\yourname\greenvalley\parcels_polygon_Select_intersect.shp
18. Click OK. Now you have the new shape file in the TOC.
19. Right-click on the new layer and choose ‘Properties’. Now select the Symbology
tab and choose Categories in the left hand ‘Show’ box. Choose ‘Unique values’
and select from the ‘Value Field’ drop-down menu, ‘Type’. At the bottom of the
dialog box, click on the ‘Add All Values’ box. Now change the line next to the
number ‘3’ to the major road template.
20. Now turn off all layers except the …Select_intersect and …Select_Buffe layers.
21. Make a query on the parcels_polygon_Select_intersect layer where the Type is
equal to 3.
22. Now open the attribute layer of the …Select_intersect layer. At the bottom you
should see 61 of 477 Selected. Go ahead and click the ‘Selected’ button instead of
‘All’. Now you see the 61 tuples selected.
23. Right-click on the parcels_po column and choose to ‘Sort Ascending’. Keep the
table open.
24. Now Right-click on the …Select_Buffe layer and open its attribute table.
25. Sort the parcels_po column as well. The parcels_po number is a unique number
associated with the buffer zone you previous created.
26. Now compare the two tables to see if the parcel_po appears in both. If it does not
then we can conclude that the major road that we intersected into the buffer zone
does not exist, thus we are able to build a park on that vacant lot because it meets
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the requirements of the city. Use the chart below to help you organize.

parcel_po for Buffer

parcel_po for Intersect

appear in both?

1227







1274







1279







1318







1358







1442







2173







2258







2300







2577







2633







2665







2682







27. Were there any that DID NOT appear in both? Well you should have noticed that
2577 buffer zone did not intersect with a major road. Therefore we can suggest to
the city that the parcel which is associated with number 2577 is the best
suggestion for converting a vacant parcel into a park given their constraints. Close
the two attribute tables, leaving the one with selections, still selected.
28. Finally, we need to produce an output map. First arrange your layers in the TOC,
so that the parcels_polygon_Select layer is first, the
parcels_polygon_Select_intersect layer is second, and the
parcels_polygon_Select_Buffe layer is third and the streets layer is fourth and
make sure these are the only layers ‘checked’.
29. Now, Right-click on the Select_Buffe layer and open the attribute table. On the
far left select the ‘square tab’ associated with the tuple (row) 2577. Now the
whole record for 2577 should be seen on your display surrounding the buffer you
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created for that zone. Close the table. Now click on the ‘Selection’ tab on the
bottom of the TOC, and right-click on the name parcels_polygon_Select_intersect
and choose ‘Clear Selected Features’. Go back to the ‘Display’ tab at the bottom
of the TOC. Your display should look something like below.

30. Referring to Figure 1. on page 4, notice the ‘Layout View’ button. Go ahead and
click it and from here you can use the ‘Insert’ command on the main menu to add
several map elements such as a north arrow, scale bar, and legend. Also use the
‘Draw’ toolbar to help you add text where appropriate and use the zooms and pan
options when adjust your box sizes. Here might be a suggest look for your output:
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31. Print your output on the black & white laser and evaluate it for any errors. Adjust
as necessarily until you are satisfied. Now print your final version in color.
32. CONGRATULATIONS! You are done!

This concludes your refresher course in ArcGIS. I hope that is has been helpful for you to
go through some of the different operations and procedures in ArcCatalog, ArcMap, and
ArcToolbox. If you have any questions or suggestions, please let me know.

Citations:
ESRI 2004, ArcGIS 9: Getting Started with ArcGIS. Redlands, CA: 272 pages.
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